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Le Studio Bridge a des fonctions de controle de DAW. Sion le
régle en mode de contréle de DAW, ses commandes peuvent
servir aux opérations de base dans l'application DAW. Cela
comprend 'enregistrement, la lecture, I'arrét et d’autres
fonctions de transport.

Les émulations de protocole Mackie Control (MCU) et HUI
sont prises en charge, ce qui permet de contréler Cubase,
Digital Performer, Logic, Live, Pro Tools, Cakewalk et d'autres
applications DAW courantes.

Marques commerciales

® TASCAM is a registered trademark of TEAC Corporation.

® Microsoft and Windows are either registered trademarks or
trademarks of Microsoft Corporation in the United States
and/or other countries.

® Apple and Mac are trademarks of Apple Inc. in the United
States and other countries.

® Avid and Pro Tools are either registered trademarks or
trademarks of Avid Technology, Inc. or its subsidiaries in the
United States and/or other countries.

® Cubase are registered trademarks of Steinberg Media
Technologies GmbH.

® Cakewalk is a registered trademark are trademarks of
BandLab Technologies Inc.

® Other company names, product names and logos in this
document are the trademarks or registered trademarks of
their respective owners.
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Opérations sur le Studio Bridge

Préparation de I'unité

Branchement a un ordinateur

Reportez-vous a « Branchement d’un ordinateur » dans le
chapitre « 4. Préparation » du mode d’emploi du Studio Bridge,
et branchez un ordinateur.

Consultez également le chapitre « 13. Fonctions d'interface
audio USB » et faites les réglages.

Lancement du mode de controle de DAW

1. Quand l'enregistreur du Studio Bridge est a l'arrét,
sélectionnez DAW CONTROLLER (contréleur de DAW) en
écran MENU, et ouvrez I'écran MODE.

Pour des instructions d’utilisation, voir « Procédures
d'utilisation du menu » dans le chapitre « 3. Nomenclature
et fonctions des parties » du mode d'emploi.

| mMooE |
MCU - Liw
HUI - Prn Tnnls
MEU - Cubsase
=5id I I

2. Sélectionnez le mode de controle de la DAW utilisée.

Pour plus de détails sur les réglages, voir le mode d’emploi
de l'application DAW utilisée.

Options : MCU - Live,
HUI - Pro Tools,
MCU - Cubase,
MCU - Cakewalk,
MCU - Logic,
MCU - DP,
MCU - Reaper,
MCU - Studio One,
MCU - Cubasis

3. Pressezla molette MULTI JOG.
Un message de confirmation apparaitra.

DA COHTROLLER
Start the DAW

control ler mode.

Are wou sure 7

Pressez la touche F1 IIEEM pour revenir a I'écran MODE.

4. Pressezlatouche F4 IREEA
Cela ouvre I'écran DAW CONTROLLER et permet de faire
fonctionner la DAW.

DAN COMTEOLLER

MCU - Live

MARKER ——
= EER

(Exemple d'écran avec « MCU - Live » sélectionné)

Sil'unité a été éteinte alors qu'elle était en mode de contréle
de DAVW, elle retrouvera ce mode au redémarrage. Pour
I'utiliser en mode normal, quittez le mode de contréle de
DAW avec la touche F1 I=3ad,

Abandon du mode de controle de la DAW

1. Pressez latouche F1 pour afficher le message
suivant.

I DAW COMTROLLER I

Are ygou sure

to exit?y

2. Pressez latouche F4 IEIZ pour mettre fin au contréle de
la DAW.

Son envoyé a l'ordinateur

Le signal audio envoyé a l'ordinateur est toujours analogique.
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Opérations sur le Studio Bridge

Commandes utilisables en mode de controle de DAW

Les commandes suivantes du Studio Bridge peuvent étre utilisées en mode de contréle de DAW.

® Les touches et la molette colorés en bleu dans l'illustration ci-dessous sont actifs.

Touche REC

Elle peut servir a armer I'enregistrement.

Molette MULTI JOG

Elle peut servir au repérage (a la localisation).

Touches de fonction

Leur fonction dépend de ce qu'affiche I'écran du DAW CONTROLLER.
Pressez la touche MENU pour passer d'une fonction a l'autre.

) — e —
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Ecran DAW CONTROLLER MARKER

DA COMTEOLLER

MCU - Live

@ Utilisez la touche F2 pour poser des marqueurs.
® Avec les touches F3 IEZ3M et F4 BEEM, déplacez-vous entre

les marqueurs.

MARKER ——
B EER

(Exemple d'écran avec « MCU - Live » sélectionné)

Ecran DAW CONTROLLER TRACK

DA COMTEOLLER

MCU - Live

(Exemple d'écran avec « MCU - Live » sélectionné)

® Pressez la touche F2 IEREM pour changer la fonction de

bouclage de la DAW.

® Avec les touches F3 IE=El et F4 M=, déplacez-vous entre
les pistes qui peuvent étre controlées.
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Réglages de diverses applications DAW

Pour permettre la réception de messages venant de I'application 3. Réglezl'entrée sur « Studio Bridge MIDI (Port 2) ».
DAW, faites d’abord passer le Studio Bridge en mode de contrble
de DAW, puis configurez I'application DAW.

b= Preferences x
Live =
.
Windows 2 2
Les écrans suivants sont issus de la version 12.0.1 de Live.
1. Cliquez sur « Options » > « Préférences... »
MackieControl Clv|[None | [None ]
ws Untitled - Ableton Live 12 Trial [None Y| [None v
Fil Edit Create Playback Vi N; Opti | e T
= mE e T e Ep Nene vl studio Bridge MIDI (Port 2) ]
RPPecsibility > e S e S S =
Edit MIDI Map Ctrie M Nene ]| studio Bridge MIDI (Port 4) ~
Edit Key Map Ctrl+K
Computer MIDI Keyboard ]
MIDI Ecitor Note Preview 4. Réglez la sortie sur « Studio Bridge MIDI (Port 2) ».
~  Browser File Preview
External Sync P
~  Delay Compensation tin Preferences x
Reduced Latency When Monitering
Time Ruler Format >
Marrow Grid Ctrl+1
‘Widen Grid Ctrl+2
Triplet Grid Ctrl+3
Snap to Grid Crl+4
Snap Autemation to Grid
Fixed Grid Ctrl+5
Draw Mode B
Step Input Mode Ctrl+Shift+B
Highlight Scales K

+  Chase MIDI Notes
~ MIDI Envelope Auto-Reset
Retune Set On Loading Tuning Systems

~  Solo Switches

Cuc Switches Studio Eridge MIDI (Part4)
~ Soloin Place

;“Dk‘;\p - La touche M du Studio Bridge s'allumera, indiquant que la
rrangement Overdul Ve .oz
i télécommande est activée.
Audio Engine On Ctrl+ Shift+ AR+ E
Preferences... Ctrl+, l

2. Sélectionnez l'onglet « Link, TEMPO & MIDI », et réglez la
surface de contréle sur « MackieControl ».

e Preferences X
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Réglages de diverses applications DAW

Mac 4. Réglezla sortie sur « Studio Bridge (DAW Control OUT1) ».
Les écrans suivants sont issus de la version 12.0.10 de Live.

1. Cliquez sur « Live » > « Préférences... »

}File Edit Create Playb

| Settings...
I

de Live $H
Hide Others "3t H
Show All

MackieControl Studio Bridge (DY { Dump J

.- PSP

|| Studio Bridge (DAW Control OUT3)

Quit Live
La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

2. Sélectionnez l'onglet « Link, TEMPO & MIDI », et réglez la

surface de controle sur « MackieControl ». Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
® Touche F3 IEZEM (écran DAW CONTROLLER MARKER)
® Touche F4 IEEM (écran DAW CONTROLLER MARKER)
® Touche F2 IFFTM (écran DAW CONTROLLER TRACK)
® Touche F3 BE=MM (écran DAW CONTROLLER TRACK)
® Touche F4 IE=3M (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«/»»>

® Touche H

® Touche » /11

® Touche @

® Touches REC (1-8)

L'armement de I'enregistrement (REC READY) peut étre
contrélé pour 8 pistes. Pour utiliser la fonction dans un projet
ayant 9 pistes ou plus, pressez la touche MENU de I'unité et
ouvrez I'écran TRACK, puis utilisez les touches F3 IE= et
F4 M pour accéder aux pistes souhaitées.

3. Réglezl'entrée sur « Studio Bridge MIDI (DAW Control IN1) ».

MackieControl_¥|fNene ____ vl[Nene  w|( Dump

ﬁstudin Bridie (DAW Control IN1) E ']

71 (D
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Réglages de diverses applications DAW

Pro Tools
Les écrans suivants sont issus de la version 2024.6.0 de Pro Tools
12 Ultimate.
1. Cliquez sur « Setup » > « Peripherals... ».
@Y Pro Tools

File Edit View Tack Clip Event AudioSuite Opticns

B Edit: Untitled

Machine Track Arming Profiles...

Video Sync Offset...

Session Ctrl+ @
Current Eeet+Frames Position...
Current Timecode Position...

External Timecode Offset...

MIDI L4

Click/Countoff..
Keyboard Shortcuts...  Start+Shift+K

Preferences...

Sélectionnez lI'onglet « MIDI Controllers », et réglez Type sur
«HUI ».

Réglez Receive From sur « MIDIIN2 (Studio Bridge MIDI)
[Emulated] ».

Sur un Mag, réglez-le sur « Studio Bridge DAW Control IN1 ».

MIDI Controllers

Réglez Send To sur « MIDIOUT2 (Studio Bridge MIDI)
[Emulated] ».

Sur un Mag, réglez-le sur « Studio Bridge DAW Control
OUT1 ».

R B

Pour la rangée #2, réglez également Type sur « HUI »,
Receive From sur « MIDIIN3 (Studio Bridge MIDI)
[Emulated] » et Send To sur « MIDIOUT3 (Studio Bridge
MIDI) [Emulated] ».

Pour la rangée #3, réglez également Type sur « HUI »,
Receive From sur « MIDIIN4 (Studio Bridge MIDI)
[Emulated] » et Send To sur « MIDIOUT4 (Studio Bridge
MIDI) [Emulated] ».

6. Cliquezsur « OK».

Peripherals x

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
@ Touche F2 I=H=M (écran DAW CONTROLLER TRACK)

® Touche F3 IE=M (écran DAW CONTROLLER TRACK)

® Touche F4 IE=3M (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»p>

® Touche W

® Touche » /11

® Touche @

® Touches REC (1-24)
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Réglages de diverses applications DAW

Cubase

Les écrans suivants sont issus de Cubase 13.0.41.

1. Cliquez sur « Studio » > « Configuration du studio... ».

Cubase Pro Hub

File Edit Media Transporfl Studio §Vindow Help

Audio Connections... F4

MixConsaole F3
MixConsole 2
MixConsole 3
MixConsole 4
MixConsole in Project Window Alt+F3

Control Room

MIDI Remote Manager
VST Plug-in Manager

V5T Instruments F11
Audio Performance F12
Video Player F8
On-Screen Keyboard... Alt+K
Mare Options >

GoPro VR Player Remote
Head Tracking

l Studio Setup.. l

2. Cliquezsurle + en haut a gauche de la fenétre.

-
Studio Setup

Mackie Control

Note Expression Input Device

M User Commands

EuCon
JLCooper C5-10

Mackie Baby HUI
Mackie Control

JLCooper MCS-3000 Button Category Command

User A
UserB

Fl

Mackie HUI

3. Sélectionnez « Mackie Control ».

Studio Setup X

Mackie Control
mW MIDI Input
Note Expression Input Device MIDI Output
Time Display
User Commands
EuCon
JLCooper C5-10
JLCooper MCS-3000 Button Category Command
i—— User A
User B
e Fl
Steinberg Houston
Tascam DM-24 (HUI)

Shift+F1

4. Réglezl'entrée MIDI sur « MIDIIN4 (Studio Bridge MIDI) ».
Sur un Mag, réglez-la sur « Studio Bridge DAW Control IN3 ».

Studio Setup

Devices Mackie Control
MIDI Input

MiC

Studio Bridge MIDI
MIDINZ (Studio Bridge MIDI)

MIDIIN (Studio Bridge MIDI)

Category

Il faut d’abord régler « MIDIIN4 (Studio Bridge MIDI) » ou
« Studio Bridge DAW Control IN3 » sur un Mac.

5. Réglezla sortie MIDI sur « MIDIOUT4 (Studio Bridge MIDI) ».
Sur un Mag, réglez-la sur « Studio Bridge DAW Control
OUT3 ».

Studio Setup

Mackie Control
MIDI Input
MIDI Output
User Commands
(Studio Bridge MIDI)
category

MIDIOUT (Studio Brick

6. Répétez l'opération a partir de I'étape 2, en réglant I'entrée
MIDI sur « MIDIIN3 (Studio Bridge MIDI) » et la sortie MIDI
sur « MIDIOUT3 (Studio Bridge MIDI) ».

Sur un Mag, sélectionnez respectivement « Studio Bridge
DAW Control IN2 » et « Studio Bridge DAW Control OUT2 ».

7. Répétezl'opération a partir de I'étape 2, en réglant I'entrée
MIDI sur « MIDIIN2 (Studio Bridge MIDI) » et la sortie MIDI
sur « MIDIOUT?2 (Studio Bridge MIDI) ».

Sur un Mag, sélectionnez respectivement « Studio Bridge
DAW Control IN1 » et « Studio Bridge DAW Control OUT1 ».

8. Cliquez sur « OK».

f Studio Setup X

Devices Mackie Control
MIDI Input MIDIIN:
MID put MIDIOUT.

User Commands

Button Category Command
User A

User B

Fl

shift+F1

2

shift+F2

shift+F3
4

Shift+F4

short

Cancel

9. Retournez dans « Studio Setup... » et cliquez sur
« Configuration des ports MIDI ».

r Studio Setup

MIDI Port Setup
IO Port
In  MIDI

MIDI

MIDI
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Réglages de diverses applications DAW

10. Décochez les cases « MIDIIN2 (Studio Bridge MIDI) »,

« MIDIIN3 (Studio Bridge MIDI) » et « MIDIIN4 (Studio Bridge Commandes utilisables avec la DAW
MIDI) ». Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

ot s ® Touche F2 (écran DAW CONTROLLER MARKER)
® Touche F3 23 (écran DAW CONTROLLER MARKER)
® Touche F4 BEEH (écran DAW CONTROLLER MARKER)
@ Touche F2 IEH=M (écran DAW CONTROLLER TRACK)
e Touche F3 IEZM (écran DAW CONTROLLER TRACK)
® Touche F4 IEZM (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«/>p

® Touche H

® Touche > /11

11. Cliquez sur « OK ». ® Touche ®

® Touches REC (1-24)

|
.
o
.
m,
o

[a x

MIDI Port Setup

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

Il peut étre nécessaire de faire redémarrer Cubase en
fonction de la configuration de l'ordinateur sur lequel il se
trouve.
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Réglages de diverses applications DAW

5. Cochezles cases des appareils MIDI a sélectionner.

Cakewalk

Les écrans suivants sont issus de la version 2024.02 (Build098)
de Cakewalk.

MIDI Devices x

Check/uncheck to select/deselect MID| inputs and outputs. |
X . L., Double-click on a fiendly name to edit it. |
1. Cliquez sur « Edition » > « Préférences... ». re—
|
. i I Friendly M ame Device Mame
u Cakewsalk _ IUntitled Project1] | Help

Studio Bridge MIDI
MIDINZ [Studio Bridge MIDI)
MIDIIN3S [Studia Bridge MIDI)

u’iews Insert Process Project  Utilities Window Help a :UdIDB”dgele_
8 JIDIINZ (Studio Bridge M...
Ctrl+Z

IDIM 3 [Studio Bridge M...

Undo Save Import f 5 [ /]

Bédc Ctrl+Y, Ctrl+Shift+Z Tro — M JIDIIN4 [Studio Bridge M. MIDIIN4 [5tudio Bridge MIDI)
History...
art Screen  Fit Project  Keyboard
Select L4
Options |

Aim Assist L4

|
Cut . e | Friendly Mame Device Name
e @ [lrudic Bridge MIDI Studio Bridge MIDI
Copy ) B JIDI0UT2 [Studio Bridge...  MIDIOUT2 [Studio Bridge M...
Copy Special... B JIi0I0UT3 (Studio Bridge...  MIDIOUT3 (Studio Bridge M.
Paste

B JIDI0UT4 [Studio Bridge. .

MIDIOUT4 [Studio Bridge M. ..

Paste Special...
Delete

0 -None-

¥ [DMaster

Delete Special...

@ ™MDl M 5
Preferences... P
Clips v B W

2. Sélectionnez « Surfaces de contrdle ».

Move Checked Output Devices to Top

| [] Use Friendiy Mames to Represent MIDI Devices
[C'wiarn shout Mo MIDI Devices

Preferences x 6. Réglezle port d'entrée sur « MIDIIN2 (Studio Bridge MIDI) ».
Audio Select any control surface(s) you want to use in Cakewalk.
Devices % 4

Driver Settings Connected Conbrollers/Surfaces

Playback and Recarding

Controller/5Surface Settings x

Contraller/Surface In Port Out Part A W WA colr

Configuration File

Syncand Caching

ot " Controller/Surface

Playback and Recording Rebesh Frequenoy (nllscoondsy 7 % | b ackie Control i3

— WAl Disploay | [ Contiol Stips Visiblein- | Cancel
[ermm—— Gy e (e (Y05 Iriput Pt
. | | ST = | Help

3. Cliquez sur I'étoile en haut a droite de la fenétre.

E— x MIDI Devices...
Audio Select any control surface(s) you want to use in Cakewalk.

Devices

Driver Settings

Connected Conbrollers/Surfaces

e e ContoturSurtesn Pt AW e 7. Réglezle port de sortie sur « MIDIOUT2 (Studio Bridge
Sync :nn Caching MlDl) ».
:T:a;:lﬂ Recording Retesh Fraquency (niseconds) 75 % Controller/Surface Sei'tings b
1| r
s Controller/Surface
| tackie Control e i
4. Réglez Controleur/Surface sur « Mackie Control ». { Caticel !
Input Port
e D Hel
Controller/Surface Settings > MIDIINZ [Shudio Bridge MIC -~ il
Controller/Surface Output Port
Bl | - Mone --- e MIDI Devices...
| [ACT MIDI Contraller v |
ACT MIDI Contraller Lancel
Cakewalk. Genenc Surface
M ackie Contral C4 Help
b B 1 AT
MIDI Devices...
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Réglages de diverses applications DAW

8. Cliquez sur « OK ». ors
d R Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a

Controller/Surface Settings X [ faire fonctionner l'application DAW.
Controller/Surface oK, e Touche F3 IEE3M (écran DAW CONTROLLER MARKER)
| |Mackie Cantral ¥ — | e Touche F4 BEES (écran DAW CONTROLLER MARKER)
arce
Input Port @ Touche F2 IEH=EM (écran DAW CONTROLLER TRACK)
MIDIINZ [Studia Bridge MIC Help e Touche F3 BESE (écran DAW CONTROLLER TRACK)
o Touche F4 =M (écran DAW CONTROLLER TRACK)
Output Port ® Molette MULTI JOG (fonction de repérage/localisation)
MIDIOUT 2 [Studio Bridge b~ HMIDI Devices... ® Touches <</»>
® Touche W

9. Répétezl'opération a partir de I'étape 3, en réglant le port ® Touche »-/11
d’entrée sur « MIDIIN3 (Studio Bridge MIDI) » et le port de ® Touche @
sortie sur « MIDIOUT3 (Studio Bridge MIDI) ». e Touches REC (1-24)
La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Logic Pro

Les écrans suivants sont issus de la version 11.0.0 de Logic Pro.

1. Cliquez sur « Logic Pro » > « Réglages » > « Surfaces de
controle... ».

File  Edit

(] J About Logic Pro

Track

Navigate Record Mix View

|

Window

1 Help

[i Settings

Key Commands
Q

Sound Library

Learn About MainStage...
Services

Hide Logic Pro
Hide Others
Show All

Quit Logic Pro

Provide Logic Pro Feedback
Learn About Logic Remote..

. General...

7 Audio...
Recording...
MIDI...
Score...
Movie...

v

My Info...
#®H Y

X¥#H

Advanced...

%0 Plug-in Manager...

2. Cliquez sur « Configuration... ».

Control Surfaces... ]
> -

Reset All Settings Except Key Command Assignments...

O]

General  Audio  Recording  MIDI

Resolution of Relative Controls:

Maximum MIDI Bandwidth:

5. Pour Périphérique : Mackie Control, réglez le port de sortie
sur « Studio Bridge DAW Control OUT1 ».

Logic Pro

Navigate Record Mix  View

File Edit Track

v Quick Help

> Region: Audio Def

> Track: Audio 1

Welcome to Quick Help

Move the pointer over an item to she
show Quick Help, choose Help >
control bar.

~ Device: Mackie Control
Logic Pro Virtual Out

off

Window

ige DAW Control OUT1

Studio Bridge DAW Control OUT3

M Mackie Control

6. Pour Périphérique : Mackie Control, réglez le port d'entrée
sur « Studio Bridge DAW Control INT ».

Logic Pro

File Edit Track Navigate Record Mix View

~ Quick Help

> Region: Audio Def

> Track: Audio 1

o lInputl

Welcome to Quick Help

Window 1 Help

Move the pointer over an item to show its name and function. To hide or
show Quick Help, choose Help > Quick Help or click the ? button in the

control bar.

v Device: Mackie Control

Output Studio Bridge DAW Control OUT1

v Any

B Mackie Control

Mg ‘Studio Bridge DAW Control IN1

olol| Studio Bridge DAW Control INZ

MIDI Keys

Fader Bank Off

7. Répétezl'opération a partir de I'étape 4, en réglant le port
de sortie sur « Studio Bridge DAW Control OUT2 » et le port
d'entrée sur « Studio Bridge DAW Control IN2 ».

8. Pour Mackie Control #2 défini a I'étape 7, réglez « Décalage

Multiple Controls per Parameter: 2 &

Show Value Units For: 2 Instrument/plug-in parameters

Settings
HoH S ) ® &
Score Movie  Automation Control Surfaces View My Info  Advanced
General ~ Help Tags ~ MIDI Controllers
Bypass all while in background
v 128 A~
v 50 v %
Touching fader selects track
Control surface follows track selection
Jog resolution depends on horizontal zoom
Pickup mode
Flash Mute and Solo buttons
For Longer Labels and Value Displays
Only when all parameters fit on one page
Volume and other parameters
Controller Assignments... Set

3. Cliquez sur « Nouvelle » > « Installation... ».

File Edit Track

® Edit ~

v
> Region: Audio Del

Navigate  Record

"L v Automatic Installation

> Track: Audio 1

Mix View Window 1 Help

Control !

Move the pointer over an item to snow its name and function. To hide or

4, Sélectionnez « Fabricant : Mackie Designs » et « Modele :
Mackie Control », et cliquez sur « Ajouter ».

Manufacturer
M-Audio

M-Audio

M-Audio

M-Audio

M-Audio (Midiman)
Mackie Designs

Mackie Designs

Mackie Designs
Mackie Designs
Mackie Designs

Mackie Desians

Q

Install

~  Model
Oxygen 25 mkiV
Oxygen 49
Oxygen 49 mkIV
Trigger Finger
iControl
Baby HUI
HUI

Mackie Control

Mackie Control Extender  Logic Control

Mackie Control Extender... Logic Control

MCU Pro

Plug-in / Profile Version

Oxygen 25 mkIV

Oxygen 49

Oxygen 49 mkIV

Trigger Finger

iControl 11010

HUI 2710

HUI 24710

Logic Control 25910
255910
255910

Logic Control 2 590,

Scan All [Scan |

des banques de curseur » sur « 8 ».

& logicPro File Edit Track Navigate Record Mix View Window 1 Help

Control Surface Setup

v Quick Help
> Region: Audio Def

Device area

This area offers a visual representation of every control surface device and
control surface group available. Select an icon to set up and configure that
device using the parameters on the left.

Press %] for more info.

> Track: Audio1

' Device: Mackie Control #2
‘Studio Bridge DAW Control OUT2 Mackie Control ...
‘Studio Bridge DAW Control IN2
Logic Control
Mackie Control

(unknown)

o input1

9. Répétezl'opération a partir de I'étape 4, en réglant le port

de sortie sur « Studio Bridge DAW Control OUT3 » et le port
d'entrée sur « Studio Bridge DAW Control IN3 ».

10. Pour Mackie Control #3 défini a I'étape 9, réglez « Décalage

des banques de curseur » sur « 16 ».

& logicPro File Edit

Edit © New

' Quick Help
Dovice area
K Audiol  This area offersa

dey parar
Press 3] for more ino.

' Device: Mackie Control #:

® Mackie Control

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

® Touche F2 I=H{=M (écran DAW CONTROLLER TRACK)

® Touche F3 IEZM (écran DAW CONTROLLER TRACK)

® Touche F4 BE=EM (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»p>

® Touche W

® Touche »/1l

® Touche @

® Touches REC (1-24)
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Réglages de diverses applications DAW

DP (Digital Performer)

Les écrans suivants sont issus de Digital Performer 10.1.

1. Cliquez sur « Setup » > « Control Surface Setup... ».

@ Untitled 2

| File Edit View Region Audio Project Studi

«“or» Kl >
S ] & It WLt F L2

t Window Help
W Command... Shift+ Space
Commands Shift-L

Input Filter.
Event Chasing...
Sequence Automation Setup...
Legend...

Time Formats Ctrl+ Alt=T

Frame Rate 3
Receive Sync..

Transmit Sync...

Slave To External Sync Chel=7

Control Surface Setup...

Live Perf Mode
Audio System
Configure Audio System
Audio System Clock

2. Cliquezsur le + a droite de la fenétre.

Listen to control sw

Press +"to add a driver to your configuration.

Cancel

3. Réglez I'unité sur « Mackie Control ».

Control Surface

v Akai APCADmKII
Akai APC Key 25
Akai APC Mini
EuCon {aon)

HuUI

lcon Control

Kemplete Kontrol
Korg Keystage
Launchkey MK3
Launchpad Pro MK3
Launchpad X

4, Réglezle port d'entrée sur « MIDIIN2 (Studio Bridge MIDI) ».
Sur un Mag, réglez-le sur « Studio Bridge DAW Control IN1 ».

Control Surface

MIDIINZ (Stus MIDi)-1

8 MIDIINZ (Studic Bridge MIDI)

MIDIINA (Studic Bridge MIDI) MIDIINZ (St
Studio Bridge MIDI MIDIINZ (Studio Bridge MIDI)-4

5. Réglezle port de sortie sur « MIDIOUT2 (Studio Bridge
MIDI) ».
Sur un Mag, réglez-le sur « Studio Bridge DAW Control
OUT1 ».

Control Surface

None

MIDIOUT2 (Studio Bridge MIDI)

MIDIOUTA (Studic Bridge MID)
Studio Bridge MIDI

6. Cliquezsur « OK».

Control Surface

7. Cliquezsur le [+] a droite du champ de port de sortie pour
ajouter une unité « Expander (XT) ».

8. Réglez le port d'entrée sur « MIDIIN3 (Studio Bridge MIDI) »
et le port de sortie sur « MIDIOUT3 (Studio Bridge MIDI) ».

9. Cliquez sur le [+] a droite du champ de port de sortie pour
ajouter une unité « Expander (XT) ».

10. Réglez le port d’entrée sur « MIDIIN4 (Studio Bridge MIDI) »
et le port de sortie sur « MIDIOUT4 (Studio Bridge MIDI) ».

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

® Touche F3 IEZ3M (écran DAW CONTROLLER MARKER)
® Touche F4 IEEM (écran DAW CONTROLLER MARKER)
e Touche F3 IE=M (écran DAW CONTROLLER TRACK)
® Touche F4 IEEM (écran DAW CONTROLLER TRACK)
® Touches ««/»>

® Touche W

® Touche »>/11

® Touche @

® Touches REC (1-24)
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Réglages de diverses applications DAW

Cubasis

Les écrans suivants sont issus de la version 3.3 de Cubasis.

ATTENTION

Les versions 3.3 et ultérieures de Cubasis sont prises en
charge.

1. Cliquez sur « SETUP » > « MIDI ».

aYER| ?

SHOP SETUP HELP

Project MIDI Input Only for Armed Track

General

Audio Note Coloring

MIDI

Keys/Pads MIDI over Bluetooth
. Metronome Host

Mixdown / Freeze

2. Cliquez sur « Ports » sous « Mackie Control/HUI » dans la
fenétre.

MIDI Learn

(U] Learn

Mackie Control / HUI

Send MIDI Clock

3. Dans lafenétre Select Mackie/HUI Ports, cliquez sur « Studio
Bridge DAW Control IN1 », « Studio Bridge DAW Control
IN2 », « Studio Bridge DAW Control OUT1 » et « Studio
Bridge DAW Control OUT2 », et réglez chacun d'eux sur
« Mackie (1-8) » ou « Mackie (9-16) » comme ci-dessous.

Select Mackie / HUI Ports

4. Activez l'icéne figurant dans le cadre rouge.

Mackie Control / HUI

Port

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

@ Touche F2 IEXTEM (écran DAW CONTROLLER TRACK)

® Touche F3 HE=M (écran DAW CONTROLLER TRACK)

® Touche F4 =M (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»>

® Touche B

® Touche > /11

® Touche @

® Touches REC (1-24)
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Réglages de diverses applications DAW

Studio One

Les écrans suivants sont issus de la version 6.6.1 de Studio One.
1. Cliquez sur « Studio One » > « Options... ».

B studio One - Demo
File Edit Song Track Event Audic Transport View)

Studio One Activation...

Studio One Installation...
Backup and Restore.
Activate Purchased ltems...
Sign out (tascam_rdtl@teac.co.jp)
& SoundCloud Client
® TuneCore Client
A Macro Organizer

Language >

Voot Sl

.
' Options... Curl+, .

2. Cliquezsur l'icbne « Périphériques externes » en haut de la
fenétre, puis sur « Options ».

B Options b4

©r ©

General Audio Setup External Devices

Name y Receive From

3. Sélectionnez « Ajouter... » et ouvrez « Mackie » > « Control ».

Bl Add Device *

D odel Mackie Control
Manufacturer Mackie

D lame Control

1 Instruments

Receive From

Send To

Frontier

Send MIDI

Use M

Send MIDI Tim:

4.

Réglez « Regoit de » sur « MIDIIN2 (Studio Bridge MIDI) ».
Sur un Mag, réglez-le sur « Studio Bridge DAW Control IN1 ».

Mane

MIDIIN2 (Studio Bridge MIDI)

Réglez « Envoie a » sur « MIDIOUT2 (Studio Bridge MIDI) ».

Sur un Mag, réglez-le sur « Studio Bridge DAW Control
OUT1 ».

nd MIDI

Use MID

Send MIDI Tim

Répétez I'opération a partir de I'étape 3, en réglant « Recoit
de » sur « MIDIIN3 (Studio Bridge MIDI) ».

Sur un Mag, sélectionnez « Studio Bridge DAW Control IN2 ».
Réglez « Envoie a » sur « MIDIOUT3 (Studio Bridge MIDI) ».
Sur un Mag, réglez-le sur « Studio Bridge DAW Control

OUT2 ».

Répétez 'opération a partir de I'étape 3, en réglant « Recoit
de » sur « MIDIIN4 (Studio Bridge MIDI) ».

Sur un Mag, sélectionnez « Studio Bridge DAW Control IN3 ».
Réglez « Envoie a » sur « MIDIOUT4 (Studio Bridge MIDI) ».

Sur un Mag, réglez-le sur « Studio Bridge DAW Control
OUT3 ».
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Réglages de diverses applications DAW

10. Cliquez sur « OK ». ors
d R Commandes utilisables avec la DAW

I Qptior= X Les commandes suivantes du Studio Bridge peuvent servir a
@ . 0 o faire fonctionner l'application DAW.
o ® Touche F2 (écran DAW CONTROLLER MARKER)

General Locations Audio Setup External Devices Advanced

® Touche F3 IS (écran DAW CONTROLLER MARKER)
® Touche F4 BEEM (écran DAW CONTROLLER MARKER)
@ Touche F2 IEH=M (écran DAW CONTROLLER TRACK)
e Touche F3 IE=M (écran DAW CONTROLLER TRACK)

® Touche F4 IE=3M (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <<«/»>

® Touche B

® Touche »>/11

® Touche @

® Touches REC (1-8)

L'armement de I'enregistrement (REC READY) peut étre
controlé pour 8 pistes. Pour utiliser la fonction dans un projet
ayant 9 pistes ou plus, pressez la touche MENU de I'unité et
ouvrez I'écran TRACK, puis utilisez les touches F3 IE= et
F4 I pour accéder aux pistes souhaitées.

Options

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

REAPER

Les écrans suivants sont issus de la version de REAPER du 26 juin

2024.

1. Cliquez sur « Options » > « Préférences... ».

G REAPER v7.17 - EVALUATION LICENSE
File Edit View Insert Item Trac| Help

evord mode: normal
Record mode: time selection auto punch
Record mode: auto-punch selected items

Overlapping recording behavior >
Offset overlapping media items vertically

~  Auto-crossfade media items when editing Alt+X
Trim content behind media items when editing

~ Always trim content behind razor edits

~  Show all takes (when room) Cirl+L

Take behavior >

Ripple edit per-track
Ripple edit all tracks

«  ltem grouping and track razor/edit grouping ensbled  AhsShift=G
v Loop points linked to time selection
Snapfgrid >
Locking >
Envelope points >
Automation items >
Razor edits >

Metronome enabled

Metronome/pre-roll settings...

Solo in front

Pre-fader track metering

Show FX inserts in TCP {when size permits)
Show sends in TCP (when size permits)

Peaks display mode >

v Automatically scroll view during playback
Continuous scrolling
Smooth seeking (seeks at end of measure)

v Chase MIDI note-on/CC/PC/pitch in project playback

Extemal Timecode Synchronization >

Show REAPER resource path in explorer/finder.
Customize menus/toolbars...

5 Themes >

Preferences... Ctrl+P

-l I
soure

2. Cliquez sur « Ajouter » dans la fenétre « Control surfaces/
OSC/web control ».

) REAPER Preferences I %

Zoom7Serol/ DTt Contral surfaces/05 0/ wab contral
Envelope Colors

Editing Behavior
Envelope Display
Automation

Automation Items
Mouze
Mouze Modifiers
MIDI Editor

Media
MIDI
Peaks Generation
Video

WST Add Edit Remove (changes will be applied immediate bl

ARA Contral surface display update fequensy 15 Hez (default 15)

ReWire /DX [) Warn when errors opening surface MIDI devices

[TJClese control surface devicas when stopped and not active application
[[JGlose contral surfice devices when rendring

Find

Cancel Agply

3.

Pour le « Mode de la surface de contréle », sélectionnez
« Mackie Control Universal » et cliquez sur « OK ».

v & Control Surface Settings X
o)
Contral surface mode
En
Editi
En
Au
Ay
Ma
Ma FreSonus FaderPort
Ml FreSonus FaderPort v2 (2018)
Medi Web browser interface
o VAMAHA 01 X

Fe

Ehrincar BOF 2000 (4sing prezet |
Frontier AlphsTrack

Frontier Tranzport

HUI (partial)

Imy
Flug

v =iy

Con{

rma o omen Apply

4.

5.

| & Control Surface Settings *
Control surface mode:  Mackie Control Universal o
MID! input: MIDINZ (Studic Bridse MIDI) -
MIDI output | “

Réglez « MIDI input » sur « MIDIIN2 (Studio Bridge MIDI) », et
réglez « Surface offset (tracks) » sur « 0 ».

Sur un Mag, réglez-le sur « Studio Bridge DAW Control IN1 ».

€F Control Surface Settings X
Contral surface mode:  Mackie Control Universsl ~
MIDI input: ‘ -
H
T B _

et Etrac'ﬁ:

Size tmeak: |[MIDIING (Studio Eridee MIDI)

- Wirtusl MIDI Keyboard

[Jienore fader moves when aer & nat bene toushed

[ Mp F1-F8 to g0 to markers

|lgnare global bank offse ts (always map to tracks specified)
s map P

Réglez « MIDI output » sur « MIDIOUT2 (Studio Bridge MIDI) ».
Sur un Mac, réglez-le sur « Studio Bridge DAW Control OUT1 ».

Flone
Surfice offset (tracks
URFaciuree iackey |M\cmsoftGS Wavetable Synth

Size twealy

[Jlenore fader moves §
[T Map F1 -8 to £n to mMIDIOUT4 Etudio Eridee MIDI)

[JlEnare slobal bank offsets (always map to tracks specified)
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6.

| Gontrol surface mode:  Mackie Control Universal v

| Control surface mode:  Mackie Gontrol Unie rzsl v

Réglages de diverses applications DAW

Répétez I'opération a partir de I'étape 2, en réglant « MIDI

input » sur « MIDIIN3 (Studio Bridge MIDI) » et « MIDI output

» sur « MIDIOUT3 (Studio Bridge MIDI) ». Réglez « Surface
offset (tracks) » sur « 8 ».

Sur un Mag, sélectionnez respectivement « Studio Bridge
DAW Control IN2 » et « Studio Bridge DAW Control OUT2 »,
et réglez « Surface offset (tracks) » sur « 8 ».

& Control Surface Settings *

WDl input: MIDING (5tudio Bridge MIDI) w
MIDI output MIDIOLITS (5 tudio Bridee MIDI) “
Surface ofiset ifracks|

Size twe ok Weave at 9 unless you know what you're doing)

[Jienore fader moves when fader is not being touched
[JMep F1 -F& to go to markers
[Jtenore globsl bank offsets (always map 1o tracks specified)

=3 Cancel

Répétez 'opération a partir de I'’étape 2, en réglant « MIDI
input » sur « MIDIIN4 (Studio Bridge MIDI) » et « MIDI output
» sur « MIDIOUTA4 (Studio Bridge MIDI) ». Réglez « Surface
offset (tracks) » sur « 16 ».

Sur un Macg, sélectionnez respectivement « Studio Bridge
DAW Control IN3 » et « Studio Bridge DAW Control OUT3 »,
et réglez « Surface offset (tracks) » sur « 16 ».

@ Contral Surface Settings X

MID input: MICIIRG (5 tudio Bridge MIDI) w
MIDI cutput: MIDICHIT4 (Studio Bridge MIDI “

Surface offset racks)l 16

Size tweak - Wegve at 8 unless you know what you're daing)

[Jlenore fader moves when fader is not being touched
[ JMap F1-F% ta £o to markers
[ Jlenore global bank ofiets (shways map to tracks specified)

oK Cancel
8. Cliquez sur « OK ».
) REAPER Preferences I %
Track Matars Control surfaces/03C/ web contral
Zeom/sorol/Dftt [ Mackis Gontrol dev5.6)
Enelope olofs Mackie Control (dev 5,71
Editine Behavior Mackie Control (dev 7.8)
Envelope Display y
Antomation
Automation ltems
Mauss
Mouse Modifiers
MIDI Editor
Media
MIDI
Peaks Generation
Wideo
Impart
Plug—ins
Compatibility Add Edit FRemave (chanses wil be applied imme diately)
VST
L2/ OLAP Control surface display updste fraquency 15 Hz (defult: 15)
ARA [[] Warn when errors opening surface MIDI devices
ReWire/Dx [ Clase cantral surface devices when stapped and nat active spplication
_Ressoriit [[) Close control surface devices when rendering
Find oK |l Cancel Apphy

La touche M du Studio Bridge s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Studio Bridge peuvent servir a
faire fonctionner l'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
® Touche F3 23 (écran DAW CONTROLLER MARKER)
® Touche F4 BEEM (écran DAW CONTROLLER MARKER)
® Touche F2E (écran DAW CONTROLLER TRACK)
e Touche F3 IEZM (écran DAW CONTROLLER TRACK)

® Touche F4 IE=3M (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <<«/»>

® Touche B

® Touche »>/11

® Touche @

® Touches REC (1-24)
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Tableau d’équipement MIDI

Tableau d’équipement MIDI - Ports de controle de DAW

Fonction Transmis Reconnu Remarques
Par défaut X X
Canaux de base -
Modifiable X X
Par défaut X X
Mode Messages X X
Modifie |
i Plage (@) (@) Mode HUI : test de liaison
Numéros de note -
Plage O O Mode Mackie Control : touche, LED
Enfoncement
© O Mode HUI : test de liaison
. Relachement X X
Dynamique
Enfoncement (@) (@) .
Mode Mackie Control : touche, LED
Relachement X X
Polyphonique X X
Aftertouch yp g
Par canal X X
Pitch bend O X Mode Mackie Control : fader
(@) (@) Mode HUI : LED, commutateur
Changement de commande
(@) (@) Mode Mackie Control : encodeur
Changements de X X
programme Plagederéglage |ae |
Messages exclusifs de systéme (@) (@) Mode Mackie Control
Position X X
Messages communs de Sélection de morceau X X
systeme Quart d'image X X
Accord X X
i Horloge X X
Messages en temps réel
Commande X X
Local on/off X X
Coupure de toutes les % %
Autres notes
Test de liaison X X
Réinitialisation X X
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